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1Introduction 1

The SDS Plate Utility Software is designed for users who perform 
high-throughput analyses and need to generate SDS Plate Documents 
automatically. It is designed for use with the ABI PRISM® 7900HT 
instrument and Assays-on-DemandTM products. 

The SDS Plate Utility v2.1 software performs two related functions: 

• Creates SDS Plate Documents for Gene Expression and 
Genotyping reaction containers.

• Generates a detector information text file using the Detector List 
Builder software, based on assay information files from the 
Assays-on-Demand product CD. 

You can set up the SDS Plate Utility software to run manually or 
automatically. 

The SDS Plate Documents generated by the SDS Plate Utility are 
compatible with the SDS v2.1 Application, not with SDS v2.0.x 
applications.

Creating SDS Plate Documents

The SDS Plate Utility creates SDS Plate Documents for Gene 
Expression and Genotyping using the following files: 

• Container Setup Files (which contain plate information)
• SDS Template Documents (which contain thermal-cycling 

information)
• (optional) Assay Information Files (which contain detector and 

marker information)

Note: It is recommended that user-provided Container Setup Files be 
generated with an automated LIMS or other software mechanism. To 
generate the tab-delimited text file in Container Setup File format, 
you can also use a spreadsheet program such as Microsoft® Excel. To 
create single SDS Plate Documents, it is recommended that you use 
the graphical user interface in the 7900HT software.
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Enterprise Mode

If the application is running in Enterprise mode, a temporary SDS 
Plate Document is written to the hard disk. The temporary SDS Plate 
Document is then added to the SDS Enterprise Database and the 
temporary file is deleted from the hard disk. 

If the SDS Plate Utility and the Automation Controller software are 
connected to the same SDS Enterprise database, 7900HT instruments 
running Automation Controller software in SDS Enterprise mode 
will query the SDS database for SDS Plate Documents when a 
reaction container is presented to the 7900HT instrument. Assuming 
the SDS Plate Utility has previously saved an SDS Plate Document 
for the reaction container, the Automation Controller software will 
extract the appropriate SDS Plate Document from the SDS database.

Non-Enterprise Mode

If the application is running in Non-Enterprise mode, the output SDS 
Plate Documents are added to a designated folder on the hard disk.

If the SDS Plate Utility v2.1 AND the SDS v2.1 Application have 
been installed with the Non-Enterprise option AND with Automation 
Accessories options, the software moves the SDS Plate Document to 
the Automation Controller plate queue.

Generating Detector List Files

The SDS Plate Utility generates the Detector List File, which is a list 
of all SDS Detector information contained in Assay Information 
Files (AIF). AIF are supplied by Applied Biosystems on the Assays-
on-Demand product CD and copied to the hard disk by the user. A 
new Detector List File is generated each time the SDS Plate Utility is 
launched. Alternatively, it can be generated by launching the 
application from the Detector List Builder Windows shortcut.

Once built, you can import the Detector List File into the Detector 
Manager of the SDS software for use with the ABI PRISM 7900HT 
Sequence Detection System.

Note: The SDS Plate Utility does not provide a GUI to define 
reaction containers. For customers that do not generate plate-specific 
Container Setup Files with an automated software mechanism (e.g., a 
LIMS system), it is recommended to use the Detector List Builder to 
extract SDS Detector information from all your AIF and EDS files 
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and import the Detector List into the SDS application Detector 
Manager. You can then select the list of available “Assays-on-
Demand” detectors in the SDS application and use the SDS 
application GUI to design SDS Plate Documents.

Log Files
An ASCII text file is generated every time the application is 
launched.

The log file names have the format: SDSPlateUtil_log_yyyy-
mm-dd@hh.mm.ss.txt. 

For example: SDSPlateUtil_log_2003-01-
18@10.09.45.txt.

The log files are in the application installation directory in the “SDS 
Plate Utility Log Files” folder.

The application displays a Run Log window. You can close this 
window without affecting output to the Run Log file.

Technical Support
To contact Applied Biosystems Technical Support in North America 
by telephone, call 1.800.899.5858.

To access the Applied Biosystems Web site, go to:
http://www.appliedbiosystems.com

At the Applied Biosystems Web site, you can:

• Search through frequently asked questions (FAQ)
• Submit a question directly to Technical Support
• Order Applied Biosystems user documents, MSDS, certificates 

of analysis, and other related documents
• Download PDF documents
• Obtain information about customer training
• Download software updates and patches

In addition, the Applied Biosystems Web site provides telephone and 
fax numbers for technical support and sales facilities.
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Send Comments

Applied Biosystems welcomes your comments and suggestions for 
improving its manuals. You can e-mail your comments to:
techpubs@appliedbiosystems.com

Further Documentation
The following references contain useful information about the 
Applied Biosystems software and instrument:

• Container Setup File Format (PDF file on installation directory)
• ABI PRISM 7900HT Sequence Detection System Chemistry 

Guide
• ABI PRISM 7900HT Sequence Detection System Installation 

Guide
• ABI PRISM 7900HT Sequence Detection System Service Manual
• ABI PRISM 7900HT Sequence Detection System Site 

Preparation and Safety Guide
• SDS v2.1 User Guide and online help
• SDS Plate Utility online help
• Automation Controller online help
• Assays-on-Demand™ SNP Genotyping Products Protocol
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2Installation 2

The SDS Plate Utility v2.1 can be installed in one of two 
configurations, Enterprise and Non-Enterprise. In both 
configurations, the Detector List Builder software is installed.

Non-Enterprise

If you install on the same machine as the Automation Controller, the 
SDS Plate Utility automatically adds created SDS Plate Documents 
to the SDS Automation Controller Queue. (However, you can 
prevent adding SDS Plate Documents to the SDS Automation 
Controller Queue by running the SDS Plate Utility in DOS 
Command Line mode and using the '-noqueue' option.)

Enterprise

The SDS Plate Utility automatically adds created SDS Plate 
Documents to the SDS Enterprise Database defined during the 
installation.

Install
Note: Before installing in Non-Enterprise mode with Automation, 
install SDS v2.1 with Automation.

Note: Before installing in Enterprise mode, install and start the SDS 
Enterprise database (on the server).

To install the software:

1. Close any open applications.

2. Insert the SDS Plate Utility Software CD into the CD drive and 
close the drive door.
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3. If autoplay is enabled, the Introduction screen of the SDS Plate 
Utility installer appears momentarily. If the installer does not 
open automatically, in Windows Explorer open the CD directory 
(SDS Plate Utility 2.1) and double-click Setup.exe.

4. In the Introduction screen of the SDS Plate Utility dialog box, 
click Next.

5. Select Enterprise Mode or Non-Enterprise Mode. If you select 
Enterprise Mode, setup the database connection.

6. In the Choose Install Folder screen, select a destination directory 
for the installation. To install on the D drive (recommended), 
click Next. 

Note: If you are installing in Non-Enterprise mode on the same 
machine where the SDS v2.1 software is located, you must use 
the directory recommended by the installer.

To install on another directory, click Choose, select a directory, 
click OK, then click Next.

7. In the Pre-Installation Summary screen, click Install.

8. In the Install Complete screen, click Done.

9. Eject the SDS Plate Utility Software CD from the drive.

Upon installation, the SDS Plate Utility software creates a default 
AIF-EDS watch folder entitled “Applied Biosystems\Put AIF and 
EDS files here”. If the software is unable to create the folder or it is 
subsequently deleted, the software prompts you to specify the AIF-
EDS watch folder upon launch of the SDS Plate Utility software.

Hardware
The computer needs the following minimum hardware:

• Intel® Pentium® III processor (or equivalent), 500 MHz.
• 256 MB RAM
• CD Drive
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Software
The computer needs to have the following software:

• Microsoft® Windows NT® (Service Pack 6) or Windows 2000 
(Service Pack 2)

The SDS Plate Utility software works with the following software, 
but does not require them for installation or operation:

• SDS v2.1 (does not work with v2.0.x)
• Automation Controller

Note: Applied Biosystems recommends installing the SDS Plate 
Utility software onto the computer attached to an ABI PRISM® 
7900HT Sequence Detection System. In this configuration, the 
software can work with the SDS, Automation Controller, and 
Detector List Builder software for the instrument. 
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3Creating SDS Plate Documents3

The SDS Plate Utility v2.1 software creates SDS Plate Documents 
for the ABI PRISM® 7900HT Sequence Detection System using 
container setup files (reaction container information), SDS template 
files (thermocycle information), and optional assay information files 
(Assays-on-Demand reagent information). 

In Non-Enterprise mode, the SDS Plate Utility writes the new SDS 
Plate Documents to the local hard disk (default output folder is 
“Applied Biosystems\SDS Documents”). The software also adds the 
SDS Plate Documents to the Automation Controller plate queue if 
the SDS Automation Accessories software is available.

In Enterprise mode, new SDS Plate Documents are added to the SDS 
Enterprise database. 

Note: You must have user access level of Scientist or above to run 
the SDS Plate Utility in Enterprise mode, just as in the SDS 
application, users must have Scientist or higher privileges in order to 
save SDS Plate Documents to the SDS database.

You must designate at least one Container Setup File Watch folder. A 
Container Setup File Watch Folder is a folder on the local hard disk 
that, as the name implies, is watched by the SDS Plate Utility for 
Container Setup Files. When Container Setup Files are added to the 
Watch Folder, the SDS Plate Utility attempts to build an SDS Plate 
Document from each Container Setup File.

Each Watch Folder must contain one, and only one, SDS Template 
Document. Thermocycle information from the SDS Template 
Document is combined with the Container Setup Files added to that 
Watch folder to produce SDS Plate Documents. For example, a 
customer who has three different thermocycle protocols would need 
three SDS Template Documents and three Container Setup File 
Watch Folders. Each Watch Folder would contain one of the SDS 
Template Documents.
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Before creating SDS plate documents:

1. If you are using Genomic Assays Assays-on-Demand™ 
reagents, copy the assay information files (AIF) and electronic 
data sheets from the Genomic Assays CD to the “Put AIF and 
EDS files here” folder. (The files contain the detector 
information required for the SDS plate documents to be made.)

Note: Do not edit AIF or EDS files. Never remove AIF or EDS 
files from the “Put AIF and EDS files here” folder.

2. Place a single SDS template file (with extension .sdt and 
containing the assay method, thermal cycling parameters, and 
data collection options) into the Container Setup File Watch 
folder you intend to use. (Each SDS Template has its own Watch 
Folder.)

To create SDS plate documents:

1. Open the SDS Plate Utility software by double-clicking the SDS 
Plate Utility icon or selecting Start > Programs > Applied 
Biosystems > SDS Plate Utility. If you are running in Enterprise 
mode, you must log in at the SDS Plate Utility Log In dialog. If 
you are running in Enterprise mode, you can also use Database 
Setup.

2. If the “Select an AIF-EDS folder” dialog box appears, select a 
folder from the Applied Biosystems or other directory, for 
example, “Applied Biosystems\Put AIF and EDS files here”. 
Click Select Folder to use that folder.

3. To designate a watch folder: 
a. In the SDS Plate Utility main window, click the Add a New 

Watch Folder button. 
b. In the Select a New Watch Folder dialog box, select a 

folder from the Applied Biosystems or other directory, for 
example, “Applied Biosystems\Put Container Setup Files 
here”. 

c. Click Select Folder to use that folder.

4. Add the container setup files (containing the barcodes, sample 
IDs, and assay IDs) to the selected Watch folder. The system 
then creates the SDS Plate Documents.
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5. In Enterprise mode, the system places the SDS Plate Documents 
in the SDS database.
In Non-Enterprise mode, the system places the SDS Plate 
Documents in the “Applied Biosystems\SDS Documents” 
folder. 
In Non-Enterprise mode, if the Automation Controller software 
is present on the computer, the system also places the reaction 
containers on the Automation Controller plate queue for the 
7900HT instrument. 
The system places processed container setup files in the 
“Processed Files” folder, for example, “Applied Biosystems\Put 
Container Setup Files here\Processed Files”. Note: If the SDS 
Plate Utility is run from the DOS Command Line and the -input 
command line argument refers to a single file, the Container 
Setup File is left in its original location.
If the SDS Plate Utility software cannot make an SDS plate 
document, it moves the container setup file to the “Problem 
Files” folder, for example, “Applied Biosystems\Put Container 
Setup Files here\Problem Files”, and notes the action failed in 
the Command Prompt window.

Database Setup
The Database Options dialog allows you to change databases.

To change databases:

1. In the SDS Plate Utility Log In dialog, click Database Setup. 
The Options dialog displays the current connection:

• Host Name
• Port Number
• Service Name

2. Click New to make a new connection.

3. Enter the new Host Name, Port Number, and Service Name.

In the Options dialog, you can change the connection to a different 
SDS Enterprise Database.
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SDS Template Files
The SDS Template Document (extension *.sdt) contains thermocycle 
information used to run the plate on the 7900HT instrument:

• Thermal Cycling Conditions
• Data Collection Parameters

In order for an SDS Template Document to be combined with an 
Container Setup File, the plate size of the two files must be identical. 
For example, an SDS Template Document that defines a 384-well 
reaction container cannot be combined with an Container Setup File 
that defines a 96-well reaction container.

Creating an SDS Template
Use the SDS software to generate an SDS template file (file 
extension .sdt).

To create an SDS template:

1. Launch the SDS software.

2. Select File > New.

3. In the New Document dialog box, add container information. If 
performing quantitative PCR, add thermal cycling parameters 
and data collection options. 

Note: Do not enter sample information. You can edit detector 
and marker information, but be aware that the specific detector 
and marker information will be used in all subsequent SDS Plate 
Documents created from that template.

4. Click OK.

5. Select File > Save As to save the plate document as a template 
file.

6. In the Save As dialog box, select Files of Type > SDS Template 
Document (*.sdt).

7. Navigate to the Project watch folder, for example, “Applied 
Biosystems\Put Container Setup Files here”.

8. Click Save. 
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Creating Container Setup Files
You can use a database, LIMS software, or spreadsheet application to 
generate container setup files. Applied Biosystems recommends 
creating container setup files automatically using a database or LIMS 
software.

The format of container setup files is given in “Container Setup File 
Format Specification.”

Example container setup files are located in the “Applied 
Biosystems\SDS Plate Utility Example Files” folder. 

Container Setup Files
A Container Setup File (extension .txt) is a description of what is on a 
physical reaction container. 

Container Setup Files contain:

• Reaction container ID (barcode)
• Plate format (384/96-well)
• Detector information for RQ plates (optional): Detector Name, 

Reporter, Quencher, Description, Comment
• Marker information for AD plates (optional)
• Well content information (Sample, Detector, and Marker) - can 

reference assays defined in AIF or EDS files, by either the 
Assay ID or Vial ID

A Vial ID is a reference to a 2-D barcode on a Matrix tube shipped 
from Applied Biosystems. A Vial ID reference found in a Container 
Setup File is resolved to its corresponding Assay ID by the SDS Plate 
Utility and then processed the same as a reference to an Assay ID. No 
Vial ID references are passed through to the SDS Plate Document. 
Vial ID values are 10-digits long. The SDS Plate Utility will add 
leading zeros to any Vial ID field that is encountered that is less than 
10 digits in length. Note: For AIF files before version 2.1.3, the Vial 
ID field was located in EDS files.
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Container Setup File Specification
The Container Setup File is a tab-delimited text file. Container setup 
files cannot contain empty lines. Each line terminates with a carriage-
return character (Unicode 0x000D).

You can create container setup file templates in third-party 
applications such as a database, LIMS program, or spreadsheet 
program, such as Microsoft® Excel.

Note: Container Setup File version 4 and higher documents cannot 
be imported directly into SDS version 2.0 or 2.1 software. 

The Container Setup File format is described in the PDF document 
“Container Setup File Format” available in the SDS Plate Utility 
directory.

0_SPU_UG_Book.book  Page 6  Thursday, April 10, 2003  10:05 AM



DRAFT
April 10, 2003 10:02 am, 04_SPU_UG_Ch4.fm

SDS Plate Utility User Guide 4-1

4Detector List File for SDS Software4

Using one or more assay information files from the Assays-on-
DemandTM product CD, the SDS Plate Utility software can generate 
a list of detectors for the Assays-on-Demand reagents, using the 
Detector List Builder software.

You later import the detector information text file, called Detector 
List.txt, using the Detector Manager of the SDS software, for use 
with the ABI PRISM® 7900HT Sequence Detection System.

To create a detector information text file:

1. Insert the Assays-on-Demand CD into the CD drive of the 
computer.

2. Copy the assay information files (AIF) and electronic data 
sheets (EDS) files on the CD into the AIF-EDS watch folder, 
such as “Applied Biosystems\Put AIF and EDS files here”.
Do not edit AIF or EDS files. Do not remove files after they 
have been transferred to the watch folder.

3. Repeat steps 1 and 2 for each Assays-on-Demand CD that you 
have received.

4. From the desktop, double-click the Detector List Builder icon or 
select Start > Programs > Applied Biosystems > Detector List 
Builder. 

Note: To use the detector list file, open the SDS Software, open the 
Detector Manager, and import the Detector List.txt file to display the 
detector and marker information in the Detector Manager window. 
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Assay Information Files
An Assay Information File (AIF) is an ASCII text file shipped with 
an Assays-on-DemandTM product. There is an AIF for each Matrix 
TrakPlate container of assays supplied.

An AIF is used by the SDS Plate Utility and the Detector List Builder 
to generate a detector list file. The detector information file can be 
imported into the Detector Manager of the SDS software.

The following data fields are extracted from AIF files by the SDS 
Plate Utility:

The following fields are available in all AIF file formats:

• Assay ID
• Vial ID
• Gene Symbol
• Gene Name
• Context Sequence

The following fields are extracted in file versions up to and including 
AIF 2.1.4:

• Reporter 1
• Reporter 2 (this field does not appear in AIF 2.1.4 files for GeX 

assays)
• Quencher

The following fields are extracted from AIF files version 3.0.0 and 
later:

• Reporter 1 Dye
• Reporter 1 Quencher
• Reporter 2 Dye
• Reporter 2 Quencher

The SDS Plate Utility can process container setup files that contain 
no external “Assay ID” or “Vial ID” references, such as files made by 
the ABI PRISM 6700 sample-prep instrument. For this case, no AIF 
file or AIF watch folder is needed. (The SDS Plate Utility asks you to 
confirm this situation.)
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A Vial ID is a reference to a 2-D barcode on a Matrix tube shipped 
from Applied Biosystems. No Vial ID references are passed through 
to the SDS Plate Document. Vial ID values are 10-digits long. The 
SDS Plate Utility will add leading zeros to any Vial ID field that is 
encountered that is less than 10 digits in length. Note: For AIF files 
before version 2.1.3, the Vial ID field was located in EDS files.

The following are the data fields that define an SDS Detector:

• Detector Name
• Reporter 
• Quencher
• Description
• Comment

An AIF helps the SDS Plate Utility generate SDS plate documents, 
since it supplies information about the detectors and markers. The 
SDS Plate Utility software creates detector and marker information. 
The assay ID number and 2D bar code located on the bottom of each 
Assays-on-Demand reagent vial (vial ID) maps to the corresponding 
detector and marker information for the assay. The SDS plate 
document matches the detectors and markers to the assay ID numbers 
or 2D bar codes contained in the Well Definition List section of a 
container setup file.

In order for an SDS Template Document to be combined with a 
Container Setup File, the plate size of the two files must be identical. 
For example, an SDS Template Document that defines a 384-well 
reaction container cannot be combined with a Container Setup File 
that defines a 96-well reaction container.

AIF files are located in the default “Put AIF and EDS Files Here” 
folder or a user-specified AIF watch folder.

If running in SDS Enterprise mode, you must log into the SDS 
database before the AIF Watch folder files can be processed. 

Electronic Data Sheet Files
Prior to Assay Information Files (AIF) version 2.1.3, an Electronic 
Data Sheet (EDS) file contained the Vial IDs. AIF files version 2.1.3 
and higher contain the Vial ID field. Starting with AIF v2.1.3, EDS 
are no longer needed by the SDS Plate Utility. 
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5Using the Command Line 5

The SDS Plate Utility Software can be run from the command line of 
a Microsoft® DOS shell (Command Prompt window).

Use the command line interface to drive the application using a 
scripting language.

To run the software in Enterprise mode, the -login parameter must be 
specified, so that you can log in to the database.

Note: You must shutdown the application via the GUI if the -
continuous argument is used with the SDSPlateUtil.bat command at 
the command line prompt.

To run the software from a command line:

1. On the desktop, click Start > Programs > Accessories > 
Command Prompt.

2. At the command prompt (C:\>), enter:
cd D:\Program Files\Applied Biosystems\SDS 2.1

3. Press Enter.

4. To launch the software using the GUI, at the command prompt 
enter the command with no parameters:
SDSPlateUtil.bat

5. To launch the software with parameters, at the command 
prompt, enter:
SDSPlateUtil.bat <arguments>

An example is:
SDSPlateUtil.bat -i "D:\InputFolder" -o "D:\
OutputFolder" -t "D:\TemplateFile.sdt" -c

0_SPU_UG_Book.book  Page 1  Thursday, April 10, 2003  10:05 AM



DRAFT
April 10, 2003 10:03 am, 05_SPU_UG_Ch5.fm

Chapter 5 Using the Command Line

5-2 SDS Plate Utility User Guide

Parameters can appear in any order in the command line, however the 
parameters and their values must not be separated. The maximum 
number of parameters and values allowed is nine (9). For example, 
the above command has seven (7).

Note: You must have user access level of Scientist or above to run 
the SDS Plate Utility from the command line when using the -login 
option.

The available command line arguments are in the following table:

Argument Definition

-login "<value>" 
-l "<value>”

Only available if Enterprise option 
was installed. 
<value> has the form 
“username:password”. 
This option disables output to 
Automation Controller queue.

-queue 
-q

Adds created SDS Plate 
Documents to the Automation 
Controller queue (the default). The 
-queue command is ignored if -
login was used.

-noqueue 
-nq

Does not add created SDS Plate 
Documents to the Automation 
Controller queue.

-input "<value>" 
-i "<value>"

(required) Specifies the path of the 
project watch folder or the name of 
a single container setup file. 
To specify multiple watch folders, 
separate the added directory paths 
by semicolons (;), for example: 
SDSPlateUtil -input "D:\
InputFolder;E:\InputFolder"

-output "<value>" 
-o "<value>”

Specifies the path of the output 
folder for created SDS Plate 
Documents, for example: 
SDSPlateUtil -output "D:\
OutputFolder" 
If -output is not used, the default 
folder is: "D:\Applied Biosystems\
SDS Documents".
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-template "<value>" 
-t "<value>”

Specifies the name of the SDS 
Template (.sdt) file, for example: 
SDSPlateUtil -template 
"D:\TemplateFile.sdt" 
If the -template parameter is not 
specified, the system uses the 
SDS template file in the same 
directory as the container setup 
file. 
If the -input command value is a 
single Container Setup File, the 
-template argument must be used. 
If the -input command value is one 
or more Container Setup Plate 
Watch folders, the SDS Template 
File defined by the -template 
command is used instead of any 
SDS Template Files located in the 
Container Setup File Watch 
folders.

-assay "<value>" 
-a "<value>”

Specifies the path of the AIF file 
watch folder, for example: 
SDSPlateUtil -assay "D:\
AIFFolder" 
Note: Otherwise, the default AIF 
file watch folder is used: (D:\
Applied Biosystems\Put AIF and 
EDS files here).

-continuous 
-c

Can be added after an -input 
command specifying a folder (not 
a file) to allow the specified watch 
folders to be continuously 
monitored. 
If the -continuous command is not 
used, the software looks in the 
folder, processes the files, and 
then stops.
If the -input command specifies a 
single Container Setup File, the 
-continuous command is ignored.

-verbose 
-v

Enables a verbose output.

Argument Definition
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Glossary

AIF Watch Folder

This is the folder on the computer's hard disk where the user must 
copy AIF and EDS files shipped on CD with each assay order.

The default location for this folder is “D:\Applied Biosystems\Put 
AIF and EDS Files Here”. If that location does not exist then the 
default will be a folder called “Put AIF and EDS Files Here” on the 
drive where the application is installed.

The AIF Watch folder is checked every 5 seconds by the application 
(if running in GUI mode or in DOS Command Line mode with the -
continuous option) to see if any new AIF and/or EDS files have been 
copied to the folder. If so then information is extracted from the new 
files and the Detector Import List file is updated.

Assay Information File (AIF)

The Assay Information File is an ASCII text file that will be shipped 
on CD along with each Assay order. The file contains specific 
information describing/defining each of the Assays. The information 
in this file will also be used by the SDS Plate Utility to help create the 
SDS plate document. 

Assay Information File Versions 2.1.4 and above contains the Vial ID 
(2D barcode) field for the specific assay tubes. 

Container Setup File

This is a user-generated ASCII text file that contains the description 
of the contents of a specific (unique Plate ID) reaction container 
including well-sample information and well-assay information.

Support for both 96 and 384 well containers, as well as 384-well 
7900HT Micro Fluidic Card.
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Container Setup File Watch Folder

This is a folder on the computer's hard disk where the user must place 
their Container Setup Files. 

Each Setup File Watch Folder must contain an SDS Template 
Document. To create SDS Plate Documents the utility will combine 
each Container Setup File with the SDS Template that is in the same 
folder as the Setup Files. 

There can be multiple Setup File Watch Folders. One reason that a 
user may wish to have multiple Setup File Watch Folders would be 
that they have multiple thermocycle protocols. In this case they 
would have multiple SDS Template documents that reflect those 
protocols. Each SDS Template must be contained in a unique Setup 
File Watch Folder. Container Setup Files would be added to the 
appropriate folder depending on which thermocycle parameters were 
desired for the specific reaction container. 

Detector Import List

The SDS Plate Utility provides a mechanism to extract SDS Detector 
information from all of the user's AIF and EDS files and provide a 
list of those detectors in a format that can be imported into the SDS 
application (the Detector Import List file).

Electronic Data Sheet file

Prior to Assay Information Files (AIF) version 2.1.3, an Electronic 
Data Sheet (EDS) file contained the Vial IDs. AIF files version 2.1.3 
and higher contain the Vial ID field. Starting with AIF v2.1.3, EDS 
are no longer needed by the SDS Plate Utility.

Output Folder

For Non-Enterprise mode, this is the folder on the computer's hard 
disk where the SDS Plate Utility will write new SDS Plate 
Documents. The default location of this folder is “D:\Applied 
Biosystems\SDS Documents”.
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Problem Files

These are folders on the computer's hard disk where the SDS Plate 
Utility will write container setup files that were processed with 
errors. Each Container Setup File Watch folder will have a Problem 
Files folder. The default location of this folder is “D:\Applied 
Biosystems\Put Container Setup Files here\Problem Files”.

Processed Files

These are folders on the computer's hard disk where the SDS Plate 
Utility will write setup files that were processed without error. Each 
Container Setup File Watch folder will have a Processed Files folder. 
The default location of this folder is “D:\Applied Biosystems\Put 
Container Setup Files here\Processed Files”.

Reaction Container

The reaction container (typically a plate) contains all the chemicals 
needed to be run on the 7900HT instrument and has a unique 
identifier (usually in the form of a one-dimensional barcode). Before 
a reaction container (real-time or endpoint assay) is run on a 7900HT 
instrument, an SDS Plate Document (file or database entry) that 
contains the unique identifier of the physical reaction container must 
be created.

SDS Database

The database refers to the database part of the SDS 2.1 Enterprise 
Option package.

SDS Plate Document

The SDS Plate Document contains information needed to run a 
reaction container on the 7900HT instrument. The SDS Plate Utility 
creates an SDS Plate Document for each Container Setup file that is 
successfully processed. 

SDS Template

The SDS Template document is generated by the SDS application. To 
be used by the SDS Plate Utility, an SDS Template must, at a 
minimum, contain thermocycle run conditions. 
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